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Niagara 4 Installation Guide About this Guide

About this Guide

This topic contains important information about the purpose, content, context, and intended audience for this
document.

Product Documentation

This document is part of the Niagara technical documentation library. Released versions of Niagara software
include a complete collection of technical information that is provided in both online help and PDF format. The
information in this document is written primarily for Systems Integrators. To make the most of the information
in this book, readers should have some training or previous experience with Niagara software, as well as
experience working with JACE network controllers.

Document Content
This guide provides essential instructions on how to install Niagara 4 software.

Topics in this document include information on system and license requirements and how to get started with
Workbench. Topics also include descriptions of the Niagara 4 directory structure and Niagara homes.

Document change log
Changes to this document are listed in this topic.

May 1, 2025
e Updated supported operating systems and database software tables in "Important information" chapter.
e Edited "Editing silent.properties file" topic in "Silent Installer" chapter.

September 11, 2024

* Updated supported Operating Systems, supported Relational Databases, and supported Web browsers
tables for version Niagara 4.14 supervisor.

March 27, 2024

e Updated hardware requirements for Niagara 4 supervisor.

December 21, 2023

* Inthe “Silent Installer” chapter, added information about the location of the silent.properties file.

e Updated "Supported operating systems" topic. to show support for Windows Server 2022 in Niagara
4.10ub.

July 25, 2023

e Added “Silent Installer” chapter (Niagara 4.13).

e Added JACE reference to “Setting the system passphrase” topic.

e Updated the 4.13 table for Supported operating systems, Supported web browsers, Supported relational
database software and Supported mobile operating systems. Supported operating systems

October 17, 2022

Updated the 4.12 table for Supported operating systems, Supported web browsers, Supported relational
database software and Supported mobile operating systems.

November 29, 2021

¢ Updated 4.11 column in these tables: operating systems, web browsers, relational database software and
mobile operating systems.

¢ Updated two examples with more recent Niagara version numbers.
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April 5, 2021
Corrected the supported relational databases table.

Related documentation
Additional information about Niagara platforms, installation and operation Workbench is available in the

following documents.
* Niagara Platform Guide
e Getting Started with Niagara
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Chapter 1. Important information

The topics in this section include a short quick start task as well as hardware, licensing, and operating system
requirements for installation. Refer to the Niagara Community Resource Center at https://docs.niagara-
community.com for the latest versions of the following information.

Before initiating a Niagara installation, verify that you can meet all hardware and software requirements
described in this section.

Quick Start

This is a quick summary of installation; see the following sections for more detailed information.

Prerequisites:
Your PC meets the PC requirements.

Step 1. Download the latest build.
Step 2. Run the appropriate Installer (Installer x32.exe or Installer x64.exe)and follow the
installation wizard steps to define the requested information, such as:
* Installation location.
* Installation options including the installation of start menu and desktop shortcuts and tiles.
* Finish installation options, including whether to launch Workbench after installation and load
the start platform daemon.

Step 3. Launch Workbench and confirm your license.

PC requirements

The Niagara Framework® requires an adequate processor, hard disk, memory and speed to run complex
building models.

Niagara 4 Supervisors may run acceptably on lower-rated platforms or may even require more powerful
platforms, depending on the application, number of data points integrated, data poll rate, trend collection
rate, number of concurrent users, performance expectations, etc. The minimum hardware requirements
include:

® Processor: Intel® Xeon® CPU E5-2640 x64 (or better), compatible with dual- and quad-core processors

* Operating System: Windows 11 and 10 Pro x64-bit; Windows Server 2022 and 2019; Linux x64-bit: RedHat
Enterprise Linux 8.7, Ubuntu 22.04

* Browser: Chrome, Firefox, Microsoft Edge

* Mobile Browser: Safari on iOS, Chrome on Android Relational Database (optional): MS SQL Server 2019,
2016; Oracle 19¢; MySQL 8.0.

* Memory: 6 GB minimum, 8 GB or more recommended for larger systems
¢ Hard drive space: 4 GB minimum, more recommended depending on archiving requirements.

e Display: Video card and monitor capable of displaying 1024 x 768 pixel resolution, 1080p (1920 x 1080)
minimum resolution recommended.

* Ethernet 100 Mbit or 1Gbit NIC (network interface card) with TCP/IP support
* Network Support: Ethernet adapter (10/100/1000 Mb with RJ-45 connector).
e Container Engine (for Containerized Supervisors): Docker.

¢ Valid license

* Internet access for confirming your license.
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As a multi-threading Java application, the Niagara Framework® can take advantage of the added power
available in multi-core processors. A processor that goes beyond minimum requirements, such as the current
Intel Core i3, i5, i7 or AMD A6, A8, A10 series processors, can provide performance benefits.

Supported operating systems
The Niagara Framework® supports “Professional”, “Enterprise”, and “Ultimate” level operating systems (OS)
as shown in the following tables.

Niagara 4.14 - 4.15: supported operating systems
Refer to the Niagara Community Resource Center at https://docs.niagara-community.com for the latest
versions of the following information.

Niagara Niagara

Operating Systems 414 4.15
Red Hat Enterprise Linux 8.x 64-bit Yes Yes
Red Hat Enterprise Linux 8.7 Yes Yes
(Supervisor
only)
Red Hat Enterprise Linux 9.x 64-bit Yes
Ubuntu Desktop & Server 20.04 LTS Yes Yes
Ubuntu Desktop & Server 22.04 LTS Yes Yes
Ubuntu Desktop & Server 24.04 LTS Yes
Windows Server 2016 Yes Yes
Windows Server 2019 Yes Yes
Windows Server 2022 Yes Yes
Window Server 2025 Yes
Windows 10 (64-bit) Yes Yes
Windows 11 (64-bit) Yes Yes

NOTE: To install Niagara on a Windows host, you must be logged in to Windows as a user with administrator
privileges.

Java installation and disabling an earlier Java plugin

The Java SE Runtime Environment (JRE) 8 (1.8.0.241.0.1) must be installed on any client PC that will access the
station with a browser and Workbench web profile.

Prerequisites:
You downloaded and installed the latest JRE 8.

The free download is available at: java.com/en/. After installing JRE 8, ensure that the Java plugin for any
earlier versions is disabled:

Step 1. Under the Windows Start menu, click All Programs > Java > Configure Java > View.

NOTE: If the View button appears disabled, then only one JRE version is installed. Clicking Java >
About Java (under the Windows Start menu) shows installed version(s).

Step 2. Confirm that only the JRE 1.8 plugin is enabled, as shown here. For any version other than 1.8,
click the check box in the Enabled column to deselect.
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L Java
| £ About Java
&s| Cheds For Updates

| £ Get Help \

L) i =10l

« @ General| Update Java | Secuity | Advanced |

Search|  ¥iew and manage Java Runtime versions and settings for Java applications and applets.

ﬁ E, b .
[ Tstart s
x4
User | system |
Platform | Product | Locaton | Path Runtime Parameters | Enabled
B 1.8.0_25 |tip:/fjava.s... [£i\Program Files\Java... [+

Supported web browsers

Use a late version HTML5—-capable web browser, such as those shown in the following tables.

Niagara 4.14 - 4.15: supported web browsers

Refer to the Niagara Community Resource Center at https://docs.niagara-community.com for the latest
versions of the following information.

Web browser Niagara 4.14 Niagara 4.15
Google Chrome (mobile, tablet, desktop) Yes (v125) Yes
Mozilla Firefox Yes (v126) Yes
Microsoft Edge Yes (v125) Yes
Safari on iOS (mobile, tablet) Yes (v15) Yes
Niagara Web Launcher Yes Yes
Chrome on Android (v85) Yes Yes

NOTE: The following browsers do not support the WbApplet (Wb Web Profile):
® Google Chrome version 45 and higher

¢ Microsoft Edge

* Firefox version 42 and higher

* Opera

Supported relational database software

The following tables list third party relational database servers which can integrate with specific releases of
Niagara 4.
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Niagara 4.14 - 4.15: supported relational database software
Refer to the Niagara Community Resource Center at https://docs.niagara-community.com for the latest
versions of the following information.

Relational database servers Niagara 4.14 Niagara 4.15
MySQL Server 8.0 (mysql-connector-java-8.0.24) Yes Yes
MySQL Server 8.4 (mysql-connector-java-8.0.24) Yes
MySQL Server 9.0 (mysql-connector-java-8.0.24) Yes
MS SQL Server 2016 (13.0) Yes Yes
MS SQL Server 2017 (14.0) Yes Yes
MS SQL Server 2019 (15.0) Yes Yes
MS SQL Server 2022 (16.0) Yes

NOTE: Oracle 12g is not supported. MySQL 8.0 and MySQL 5.7 are both tested with connector version:
8.0.13. Connector 5.1.46 works with MySQL 5.7.

License requirement

You can install Niagara 4 on any PC with a supported Windows operating system. However, to successfully
start Workbenchapplication framework, you must have a license file installed.

You only have to license the application on your computer once, typically soon after you finish installation by
starting Workbench.

Your product purchase creates an “unbound” license on the online licensing server. The server may email you a
corresponding license key—a unique string that corresponds to your license.

32-bit vs. 64-bit installations

For earlier versions of Niagara, a number of factors can determine which type of installation is required. These
restrictions do not apply to latest versions of Niagara, which require 64-bit PCs and Niagara 64-bit software.

Newer PCs run a 64-bit Windows operating system. On these computers, the Niagara 4 64-bit install provides
certain advantages. Most notably, the 64-bit Java VM (Virtual Machine) does not have a 2 GB memory limit.
Coupled with a typical configuration that has 4 GB or more of RAM installed in the host PC, this allows a
Supervisor host to run more effectively in a large installation. Depending on the PC host hardware, a 64-bit OS
may provide other performance benefits.

However, in the following cases, it may be more effective to install the 32-bit version on a 64-bit Windows PC:

* When installing earlier version of Niagara on an engineering workstation that is licensed to run stations
engineered for a Lonworks network (LonNetwork component) with the eventual intention of installing on a
remote controller.

The term "engineering workstation” refers to an installation on a PC, which is used to commission
controller hardware and perform application engineering on both offline and online stations. In some
cases the “engineering workstation” may also be licensed to run a station to facilitate application
development and testing.

CAUTION: Although this configuration may work for some installations, be aware that the LON FTT-10 USB
adapter is NOT supported. Consequently, results are not guaranteed. Use of the non-supported LON
FTT-10 USB adapter is done at your own risk.

* When your Supervisor contains limited RAM (less than 4 GB). In this configuration, shorter 32-bit memory
pointers could be advantageous. A station running in a 64-bit VM requires more memory than the exact
same station running in a 32-bit VM.

NOTE: If you install a 32-bit Niagara 4 version on a 64-bit Windows OS, you could cause licensing
confusion if you later install a 64-bit version on the same host.
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If you attempt to install the 64-bit Niagara 4 version by selecting Installer x64.exe on a 32-bit Windows
OS, the Installer window displays an error, which alerts you that it is not a valid Win32 application.

Determining installation version (32-bit or 64-bit)

You can determine which version of Niagara 4 installation is on a PC using either of the following methods. This

procedure is not required for the installation of 64-bit Niagara version, which require a 64-bit PC.

* Make a platform connection to your local machine and look at the Platform Administration view. Check
the JVM information, which indicates either: win-x86 for a 32-bit installation or win-x64 for a 64-bit

installation, as shown here:

Platform Administration

# view Details

%, update Authentication

% Change HTTF Port

2] change S5L Settings

Change Date/Time

S¢ Change Output Settings

E: View Daemon Output |

Configure Runtime Profiles
*T) Backup |
Commissioning

Reboot

Baja Version
Daemon Version
System Home
Uzer Home

Host

Daemon HTTP Port
Daemon HTTPS Port
Hoast 1D

Model

Local Date

Local Time

Local Time Zone
Operating System
Niagara Runtime
Architecture

Tridium 4.0.8

40,0
Cinlagara\Niagara-4.0.3
C\Programbata\MNiagarad.0
My Host:

3011

5011

Waorkstation

14-Jan-15

14:30 Eastern Standard Time
America/New_York (-5/-4]
Windaows 7 Serviee Pack 1 (8.1
nre-core-win-xE6 (4.0.3)

%25

Enabled Runtime Profiles rt,seuwwh
I Java Virtual Machine oraclesjre-win-x86 Pracl.e Corporation 1.8.0.25
Niagara Stations Enabled enabled

* Make a station (Fox) connection, look at the Java Version property in the Station Summary view on the
top level Station node, or else the Java VM Name property in the Platform Service Container Plugin view
(default view of the PlatformServices container). Only 64-bit installations show Java Hotspot(TM) 64-Bit
Server VM. Whereas 32-bit installations show Java Hotspot(TM) Server VM.

March 12, 2025
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Chapter 2. Installation

The Installation wizard installs both Niagara Framework® and Workbench on a Supervisor or engineering
workstation.

Launch the installation program by running one of the Installer files located in the files extracted from a
downloaded software zip file (or possibly in an installation CD).

NOTE: Installation files can vary from one vendor (org) to another, consequently some installation items or
dialog options mentioned in this document may not appear. Conversely, some files may include additional
installation items or options that are not covered in this document. As needed, consult the technical support
resource for your brand and sales channel.

Niagara 4 promotes security by storing system files and user files in separate home folders. The daemon home
folder defaults to Programbata\Niagara4.<n>\<brand> (where <n> is the software version and <brand>
is your product name).In Niagara, you can change the location of the daemon home. Look for this option when
running the Installation wizard.

The system writes the new location to the registry at HKEY CLASSES ROOT\Applications\wb.exe\
installations along side the other install (latest/N4latest) registry keys it maintains. If this registry key
exists, the Windows NRE uses the location specified. If the key does not exist, the installation uses the default:
ProgramData\Niagara4.<n><brand> (where <n> is the software version and <brand> is your product
name).

Close other applications before you run one of the Installer files.
Related concepts

Silent Installer

Downloading the latest build
Unless you have a copy on physical media, first download the latest build from Niagara Community. This topic
explains the importance of extracting the files from the download before running the installer program.

Step 1. If you do not already have a copy, download the latest software zip file from Niagara Community.

Step 2. Extract (unzip) its contents to a local folder.

NOTE: You must extract (unzip) the zip file to a local folder before starting the install, and use the
unzipped files for the installation. Although Windows allows you to see the contents of a
compressed zip file and even to launch an executable without extracting files, an attempt to install
the software this way will fail.
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Result

Figure 1. Installation files extracted from downloaded zip

i dev
; det
: docs
L install-data
. modules
. overlay
£ | install,html
éﬂ*lnstaler_xﬁi’f.m
'ﬂ-lnstalcr_xﬂﬁ.r_m:
=] loge. png
i3 | style.css
%Lhnslull:r_xﬁ.l:xl:
ﬁf Uninstaller_x85.exe
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File folder
File folder
File folder
File folder
File folder
File folder

HTML Docu...

Application
Application

PNG File

Cascadng ...

Application

Application

1ES
437 kB
AT EB
JNES

3EB
325 KB
HIKE

Running the installation program

The installation program provides sections that step through necessary install options.

Niagara 4 Installation Guide

The installation program windows have Next and Back control buttons. Click Next to advance to the next step.

Click Back to return to a previous window to review or make a change.

NOTE: A best practice for installing an upgrade build to any Niagara version is to clear your browser cache
prior to installation. This removes any cached web resources that have changed since the previous installation

or upgrade.

Step 1. Inthe folder containing the extracted software zip file, right-click on the appropriate Installer file
for your system, 64-bit (required for latest Niagara versions) or 32-bit or 64-bit (for earlier Niagara

versions), then select Run as administrator.

NOTE: On launching the Installer, if you receive an error message stating that the software is not
supported on the current operating system, it may be due to a file property setting. Check the
Installer file properties Compatibility tab to be sure the option to Run In Compatibility Mode is

not selected. If it is, deselect it and run the Installer again.

When launched, the installation program opens to the Welcome window.

Step 2. On the Welcome window, click Next to continue.

Step 3. On the License Agreement window, click Yes to accept the terms and then click Next to continue.

14

March 12, 2025



Niagara 4 Installation Guide Installation

Selecting the installation location

This procedure describes selecting the location for the installation. The program provides the default location
which you can change if you wish. It also provides options to use this instance of Workbench as an installation
tool and to install PDF versions of all documentation.

-

Miagara 4 Installation Program @

Niagara Framework"

Destination Falder
C:\Niagara'Niagara-4.0.22.2 |

Drefauilt ” Browse. . ]
Space Reguired B13300 .
Space Available 261906720 K Bl

Thiz ingtance of YWorkbench will be used az an installation tool
4871458 K]

Install D ocumentation
146 K]

< Back

Step 1. In the installation window, accept the default destination folder or if desired, click Browse to
navigate to a different folder.

The default location is C:\niagara\niagara-4.x.<nnn> (where <nnn> is the build number).
If needed, you can directly edit the folder path (for example, changing the drive from C: to D),
or click Browse and navigate to another folder.

NOTE: If you change the default destination folder, you can click the Refresh button to
recalculate the Space Required and Space Available values.

Step 2. Accept or deselect, as needed, the two options that are selected by default:

March 12, 2025
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¢ This instance of Workbench will be used as an installation tool — Typically, you leave this
selected.

This option installs additional files that allow the installation to be used to commission
controllers. Always select this option for any Supervisor host. This option installs the
distribution (dist) files in the appropriate folders under the Niagara 4 version (software)
folder. Using a platform connection, these files allow you to commission, or provision, a
remote host to the same revision and build level as this Niagara installation.

¢ Install Documentation — Installing this documentation requires additional disk storage. It is
not required for any functions, but it is recommended for reference information.

This option installs PDF versions of the help files, hardware installation guides, and other
manuals, which are available as PDFs, in the ! docs folder.

NOTE: These are the same PDFs that are in the ! docs folder of the zipped distribution file (or
CD).

Step 3. Click Next to proceed.

Selecting the Daemon User Home location

This procedure describes selecting the location for the daemon user home folder. In Niagara, the program
provides the default location which you can change if you wish.

Miagara 4 Installation Program ﬁ

Niagara Framework"

Miagara D'aemon User Home Folder

C:AProgramD atatMiagarad. 4htridium |

Drefault ” Browse... ]

The Miagara Daemon User Home iz the location of the Miagara Daemon's
uzer data and wnning Miagara Stations.

<Back || Net> | | Cancel

Step 1. Inthe Niagara 4 Installation Program window, accept the default daemon user home folder
(ProgramData\Niagara4 <n>\<brand>, where <n> is the software version and <brand> is
your product name), or you can indicate another location.
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If needed, you can directly edit the folder path (for example, changing the drive from C: to D),
or click Browse to navigate to a different location.

CAUTION: The Daemon User Home and the Workbench User Home are intended to be installed
in distinctly separate locations. This separation of homes is for security reasons but it also
prevents certain unintended results. For example, when the two homes are installed in the same

location the Station Copier becomes unavailable, and you will not be able to make a portable
copy of the station.

Step 2. Click Next button to proceed.

Setting the system passphrase

If you are performing a new installation, the program prompts you to set a system passphrase for encryption
purposes, as shown in the following image. Once the installation program sets the system passphrase, this
step does not present again upon subsequent Niagara 4 installations.

March 12, 2025 17



Installation Niagara 4 Installation Guide

NOTE: It is important to remember the system passphrase and keep it safe. If you lose the system passphrase,
you will lose access to encrypted data.

The system passphrase is used to protect sensitive information stored on all Niagara systems, and on the
memory card in JACE-8000 and JACE-9000 controllers. The system passphrase is assigned as the file
passphrase for “portable” files, such as backups and station copies, and is used to encrypt those files. During
operations in which you transfer encrypted files to a system (restoring backups, transferring a station, etc.) you
are prompted to supply the file passphrase if it doesn’t match the system passphrase. The system passphrase
defaults to the factory default platform password. During commissioning, you will be prompted to change the
default system passphrase. You must remember the system password and keep it safe. If you lose the system
passphrase, you will lose access to encrypted data. To change the system passphrase, use the Platform
Administration tool. For more detailed information, see “System passphrase” in the Niagara Platform Guide.

-

Miagara 4 Installation Program @

Niagara Framework"

Set the pazzphraze uzed to encrupt senzgitive

infarmation an the filesysten:

Pazsphraze

Confirm Pazzphraze

cBack | MNed> | | Cancel

NOTE: Once the installation program sets the system passphrase, this step will not be presented again upon
subsequent Niagara 4 installations.

Step 1. Inthe Passphrase property, enter the passphrase and then repeat the entry in the Confirm
Passphrase property.

NOTE: A strong passphrase is required. Use 10 or more characters and include at least one of
each of the following: uppercase, lowercase, and numeric.

Step 2. Write down the passphrase you created.

NOTE: It is important to remember the system passphrase and keep it safe. If you lose the system
passphrase, you will lose access to encrypted data.

Step 3. Click Next to continue.
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Selecting install options
The options available to you differ based on the version of Windows installed on your PC or laptop.

Figure 2. Select options window

Miagara 4 Installation Program @

Niagara Framework"

[ngtall Start kM enu Shortcuts
[ Inztall Desktop Shorteuts

< Back

If using Windows 7, your shortcut options are:

* Install Start Menu Shortcuts.
This option is selected by default. This option creates a folder (group) of shortcuts in the Windows Start
Menu.

* Install Desktop Shortcuts
This option is selected by default. This option creates a number of icon-based shortcuts on the Windows
desktop.

If you are using Windows 8 or Windows Server 2012, your shortcut options are:

¢ Install Start Screen Tiles

This option creates tiles that appear on the Apps screen. The group of tiles is labeled, for example,
Niagarad4 4.1.13.0.

* Install Desktop Shortcuts
This option creates icon-based shortcuts to launch Workbench from the desktop.

Accept default settings or deselect and click Next to continue.
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Finishing install options

The final window appears after the installation of all files. The options allow you to launch Workbench
immediately, install and start the platform daemon, and copy daemon data from the prior release.
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Figure 3. Finish install window

Miagara 4 Installation Program @

Niagara Framework"

Miagara ingtallation iz complete!

Wiould you like ta?
Launch “orkbenich
Install and Start Platform D aemon
Copy Daemon Data From Prior Wersion

< Back Finish ] [ Cancel

Launch Workbench.
This option is selected by default, and recommended.
Install and Start Platform Daemon.

This option is selected by default. Any Supervisor installation, or engineering workstation PC that is
licensed to run a local station requires that you start the platform daemon.

Installing the platform daemon automatically stops and replaces any other running platform daemon with
the platform daemon from this release. Also, at any time you can install and start the platform daemon
from any installed Niagara build, using the Start menu shortcut: Install Platform Daemon.

The platform daemon runs as a Windows service. To verify that it is running, from a command prompt,
type: services.msc and press Enter. In the Services window, double-click on the Niagara named
service to see details, such as the software release and build number.

¢ Copy Daemon Data From Prior Version

This option is selected by default when the installer detects daemon data in an earlier version. When
selected, the installer copies from the earlier version the stations, templates, and other files needed for
the stations to run.
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NOTE: In Niagara, if the installer detects that there is an existing daemon home for the version being
installed, then this option is not available. This is to avoid overwriting a daemon home with an older version
when re-installing software or upgrading a newer version.
For example, if you have existing Niagara 4.10 and Niagara 4.11 daemon homes, you install a newer
version of Niagara 4.11, and, if this option was selected, the installer would copy files from the Niagara
4.10 daemon home to the existing Niagara 4.11 daemon home, overwriting more recent files. This is, most
likely, an unwanted outcome.

Click Finish to close the window and execute the selected options.

License confirmation

If you choose to launch Workbench immediately and click Finish to exit the installation wizard, a license check
routine occurs. You may briefly see a Check License popup window, and possibly a License Installed window.

License Installed indicates that Niagara has successfully found a matching (bound) license for your

Windows host on the licensing server, and installed it. When you click Continue, Workbench should
continue to open after another possible popup window (Platform Daemon Restart Required - click

Continue).

If, instead, the License Request form appears in the browser, enter the License Key string you received for
this installation, along with other information requested on the form. After submitting this form the
licensing server should finalize (bind) your license and make it available for download, and also email it to
you. If Workbench successfully confirms the license online, you can restart it after receiving the email.

Workbench is now ready for use (without further license checks) on your host, for the duration of your license.

Depending on which popup displays do the following:

22

* If the License Installed popup displays (shown below), click Continue, Workbench should continue to
open after another possible popup window (Platform Daemon Restart Required - click Continue).

= Lccnse istaked MPRISTES
I Licerse successfully instaled

@ This machine is now licensed,

e If the License Request form appears in the browser (shown below), enter the License Key string you
received for this installation, along with other information requested on the form. After submitting this
form the licensing server should finalize (bind) your license and make it available for download, and also
email it to you. If Workbench successfully confirms the license online, restart the program after receiving
the email.
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Result

Workbench is now ready for use (without further license checks) on your host, for the duration of your license.

Performing a “clean” installation

This procedure describes steps to perform a “clean” installation for a subsequent build (other than a first time
installation), which means that no files and folders from a previous installation are persisted.

Prerequisites:
* Stop the Niagara service in the Windows Services maintenance console.

The files and folders in your Workbench user home and in the platform daemon user home persist, so that all
configuration data stored there is used by each new Niagara 4 build that you install. However, for
troubleshooting or testing purposes you may prefer to start fresh rather than continue to use any of the files or
folders from the existing installation. If that is the case, you can move or rename your existing Workbench user
uome and platform daemon user home folders so that new ones are created by the installer.

Step 1. Navigate to your niagara_user_home location (C: \Users\userName\Niagara4.x\<brand>)
and rename the Niagara4.x folder.
For example, change the folder name to niagara4.x myBackup.

Step 2. Navigate to the platform daemon user home for the localhost (C: \ProgramData\
Niagara4.x\<brand>) and rename the Niagara4.x folder.
For example, change the folder name to niagara4.x daemonBackup.

Step 3. Run the installation wizard to install another build.
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During the installation, the installer creates new Niagara4.x folders in both of those locations.

Uninstalling

During the Niagara installation, the appropriate Uninstall executable is copied to the !bin subfolder, and
renamed to uninstall.exe. The installed Start menu Uninstall shortcut points to this executable.

Running the Uninstaller removes only the installation runtime files and folders in the niagara_home location
(C:\Niagara\Niagara-4.11.xx.xx). The files and folders located in your niagara_user home (C:\Users\
userName\Niagara4.x\<brand>)and in the platform daemon user home (C:\Programbata\
Niagara4.x\<brand>) are left untouched.

Step 1. Under the Windows Start menu, click All Programs and scroll to the Niagara build you wish to
uninstall.

Step 2. Click Niagara build > Uninstall.
The Uninstall Program wizard opens.

Step 3. Confirm that the wizard lists the correct build and click Next.
The wizard notifies you as it immediately begins uninstalling.

Result
On completion, the wizard notifies you that the uninstallation is complete.
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Chapter 3. Silent Installer

As of Niagara 4.13, Silent Installer allows for an automated and unattended installation of Niagara Framework
via programming.
It simplifies PC maintenance, automated testing, and bundling installations with additional applications.

Running the Niagara installer for Windows or Linux does not require user input. The properties file allows you
to generate installation choices prior to execution using the command line.

NOTE: You can find the silent.properties file in your installation file. For example, Windows images
should include the silent.properties file under the /overlay/. .. folder since the Windows installer
expects the file in that location.

The Linux images should include the silent.properties file in the root folder along with the install.sh
and install common. sh files since the Linux installer expects the file in that location.

Editing silent.properties file

Inthe silent.properties file, you have the following configuration options (presented in four sections) for
the silent installation. It runs a windowless installation and no user input is required.

Prerequisites:

* You have administrator rights to run Installer x64.exe.

NOTE:

* As a quick overview, in the silent.properties file, you will set the passphrase and
installDirectory.

* You can uninstall the previous standard version using its uninstall.exe file or with the help of the
Windows control panel. The silent.properties file allows you to configure the installation directory. If
you do not change the default configuration settings, the installation will result in a new directory with the
applicable Niagara version number. As a consequence, it will not overwrite any existing installation. If you
run the Silent Installer a second time on the same device, it will overwrite files.

Step 1. No editing needed in following section of the silent.properties file.
NOTE:

By default, the silent.properties file can be set to silentInstall=false because the Windows
installer automatically attempts to use the silent.properties file.

# Configure options for silent installation.
# This will run a windowless installation. No user input is expected.

# Set "silentInstall" to "true" to enable the installation without any user prompts.
silentInstall=false
silentInstallMessage=Proceed with silent installation.

# The license agreement acceptance is provided by the following "acceptLicense" property.
# Any value except "yes" will cause the installer to exit.
acceptlicense=yes

# Setting "showlLicense" to "yes" will print out the entire license agreement to the installation console.
showLicense=no

licenseAgreementAccept=Acceptance of the license agreement is assumed when installing silently.
licenseAgreementDecline=License agreement was not accepted.

Step 2. Edit the passphrase in the following section of the silent.properties file if the system

March 12, 2025 25



Silent Installer Niagara 4 Installation Guide

passphrase value has not been previously configured on the host.

# The system passphrase value here is used only if one does not already exist on the install target host ID.
# Your passphrase must contain:

# at least 10 characters

# at least 1 lower case character

# at least 1 upper case character

# at least 1 digit

systemPassphrase=Password10

systemPassphraseFailureMessage=Error setting System Passphrase caused installation failure.

Step 3. Edit installDirectory in the following section of the silent.properties file.

# Set the "installDirectory" to a Windows path to override the default installation directory.

# Example: installDirectory=C:\Niagara\Niagara-%version%

installDirectory=

installDirectoryNotEnoughSpaceMessage=Insufficient space is available to complete installation.

Step 4. Review the following section of the silent.properties file.

# Set "createlnstallDirectory” to "true" to create the install directory if it does not exist.
createlnstallDirectory=true

createlnstallDirectoryDeclineMessage=Creating the install directory was rejected in the configuration.
distFileSizeMessage=Dist file space required

# Set "installService" to "true" to install the Niagara daemon as a service.
installService=true

# Set "installDesktopShortcuts” to "true" to install Windows desktop shortcuts.
installDesktopShortcuts=false

# Set "installMenuShortcuts" to "true" to install the Windows Start menu shortcuts.
installMenuShortcuts=true

installStepCompleteMessage=Completed installation step
installFailureMessage=Installation failed.

Running the unattended installer

The following section describes how to execute the Silent Installer.

Prerequisites:
¢ You have edited the silent.properties file.
* You have administrator rights to run Installer x64.exe.

Step 1. Expand Niagara 4.13 (or higher) > overlay, copy the edited silent.properties file in the etc folder,
and keep all existing default settings.
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W Miagara_4.13

dev

dist

docs

install-data

modules

v overlay

cleanDist
conversion
etc

Step 2. Choose one of the following options:

* In the program folder, double-click the Installer x64.exe file.

Mame a Date modified Type
dev 7/10/2023 11:03 AM File folder
dist 7/10/2023 11:03 AM File folder
docs 7/10/2023 11:02 AM File folder
install-data 7/10/2023 11:02 AM File folder
modules 771072023 11:02 AM File folder
overlay 77102023 11:02 AM File folder

% Installer_x64.exe 3/28/2022 11:.05 AM Application

ﬁ Uninstaller_x64.exe 3/28/2022 11:05 AM Application

* Open a command prompt as administrator, change directory, and use the start command
(start Installer_x64.exe) to execute the installation.
Wait a few minutes, go to the Start menu and verify if the new entry for the Niagara software has
been added. You can watch this step being performed in the Task Manager.

Step 3. When the new Niagara software has been added to the Start menu, click Workbench and ensure
that Workbench launches and runs successfully.
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Figure 4. Windows

C:\Users\myname\Downloads\Niagara .13 >start Installer_xéu.exe

Niagara 4 Installation Guide

C:\Users\myname\Downloads\Niagara_ 4. .13>

There is no output via logging or debugging console.

Viewing the installation process

You can follow the installation process via Task Manager watching the Terminal Application from which you

launch the Silent Installer.

You will see the installation file execute within the following:
¢ Niagara Framework Installer

¢ Niagara Runtime Launcher

¢ Niagara Platform command line tools.
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Figure 5. Windows Task Manager- default
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Figure 6. Windows Task Manager — install process stages
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Chapter 4. Getting started in Workbench

Technical documents are available in the !docs folder as PDFs. Also, to view online help, open a the Help
window and explore the Table of Contents.

Desktop shortcuts and tiles

Start Menu and desktop shortcuts for Windows provide access to Workbench from the Windows desktop.
The installer sets up shortcuts or tiles for the following applications:

e Alarm Portal 4.0.<nnn> (where <nnn> is the build) is a way to start Workbench using an alarm profile.
This mode limits most menu options to the support of the Alarm Portal view, which you can configure to
monitor and acknowledge alarms from different stations. Alternatively, you can access the same view in
the standard Workbench interface, via the Tools > Alarm Portal selection. For more details, refer to
Niagara Alarms Guide.

e Console

This shortcut opens a blue Windows command prompt window with the path set appropriately for
command line utilities.

NOTE: One command that may be useful is: nre -hostid. In cases where Workbench refuses to start,
use this command to retrieve the Host ID of your Windows PC.

You can also open a console within Workbench, by choosing Window > Console. The console area then
appears at the bottom of the window.

¢ Install Platform Daemon

This shortcut installs and starts the platform daemon for this release and build of Niagara. The platform
daemon is a server process that allows automatic station restart in case of reboot or failure, as well as
remote platform management. To host a local station on this platform, you must install and start the
platform daemon. If another platform daemon instance is running, Install Platform Daemon stops the
running daemon and overwrites it with this daemon. For related details, see the Niagara Platform Guide.

e Workbench (Console)

This shortcut launches Workbench with a separate, associated Console (black) window, which can be
helpful in troubleshooting. This is similar to opening a Console (blue) window and entering the command:
wb. Either console provides client debug messages, similar to the platform Application Director, which
provides debug for the (server) station application. If a client side error occurs in Workbench, there should
be some sort of stack trace debug in the wb console output.

NOTE: If you start Workbench this way, and then close the console window,the program also immediately
closes. Any unsaved changes are lost. Be sure to save changes before closing the associated console
window. Exiting Workbench from File > Exit forces options to be saved. It also prompts for any unsaved
files in the session to be saved or discarded.

e Workbench

This shortcut launches Workbench without an associated console window. If during installation you
selected the option to start Workbench upon completion, the application uses this shortcut to start the
program when it finishes the installation process.

¢ Uninstall

This shortcut removes this Niagara installation. It provides separate options to save station files and user
files.

e Demo Station

This shortcut launches the standard demonstration station outside of normal platform daemon control. As
a convenience, the station launches using the station.exe command in a console window.

If Workbench is running, you can connect to the station (Open station). To save any changes made and

March 12, 2025 31



Getting started in Workbench Niagara 4 Installation Guide

stop the station, type quit in the Demo Station console window and press Enter. To stop without saving
any changes, close the Demo Station console window.

NOTE: Using station.exe is not the recommended way to start a local station. It is a developer utility
that allows quick access to station debug messages in the console window. While the station is running, the
console window can also process a few entered commands (to see them, in the console window enter:
help). The recommended way to start a production station is to open a platform connection and start the
station from the Application Director. This allows configuration for auto-start and restart on failure.

File locations

During the Workbench installation and platform commissioning processes, the software differentiates between
two types of files based upon the content of the files: configuration and runtime data. Files and folders that
contain configuration data reside in separate locations from files and folders that contain runtime data. This
separation enhances security by denying general access to the runtime files and allowing each user access to
only their personal configuration files.

As a result of separating configuration and runtime data, the system supports multiple home directories on the
Supervisor or engineering workstation. These homes may be identified as:

* The system home contains runtime files, such as core software modules, the JRE, and binary executables.

* Workbench user home for each user contains configuration data, including option files, and registries.

* A platform daemon user home for the Supervisor or engineering workstation contains platform
configuration data.

* Two station homes called, protected station home and station home, are part of each user home.

Homes on a Supervisor
The following table provides a summary of the Supervisor or engineering workstation homes with shortcut
information.

Home in  Home in the
the Platform
Workbench Administration
Nav tree view

File ORD
shortcut

Niagara 4 alias Windows folder location and contents

My Host > System Home niagara_home C:\niagara\niagara-<4.x.xx> I(asin

My File Niagara4.x)
System > where <4.x.xx> is the software version contains

Sys Home executable and software files.

My Host > N/A niagara_user_home C:\Users\<username>\N4-<4 . x.xx>\tridium ~ (unique to
My File Niagara 4)
System > where:

User Home

<username> iS your name to identify you as the user of
your computer.

<4.x.xx> is a software version.

Workbench user home for each human user contains that
user’s unique configuration files.

shared N/A station_home C:\Users\<userName>\N4-<4 . x>\tridium\shared A (asin
folder Niagarad.x)

where:

<username> is your name to identify you as the user of
your computer.
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Home in  Home in the
the Platform
Workbench Administration
Nav tree  view

File ORD
shortcut

Niagara 4 alias Windows folder location and contents

stations N/A
folder

N/A User Home

<4.x.xx> is a software version.

protected_station_home C:\ProgramData\N4-<4.x>\tridium\stations\<stationName> A (unique to
Niagara 4)
niagara_user_home C:\ProgramData\Niagara4.x\<brand> ~ (unique to
iag h \ \Ni 4.x\<brand (unique t
Niagara 4)
Platform daemon user home (non-human user) holds
platform daemon configuration files. Requires a local
platform connection to view in the Platform Administration
view.

Homes on a controller
On a controller there are two homes.

Home in the Platform Home in the Platform
Administration view Administration view

Niagara 4 alias OFD location and contents File ORD shortcut

File System > Sys
Home (Read Only)

File System > User
Home (Read Only)

Platform > Remote  System Home niagara_home /opt/niagara I (asin Niagarad.x)

Platform > Remote User Home niagara_user_homeYYYYY /home/niagaraContains ~ (unique to Niagara 4)

Contains operating system
data.

configuration data and the installed
and running station.
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Chapter 5. Frequently asked questions

Questions and answers cover subjects ranging from the Niagara 4 directory structure to general Framework
subjects such as, installing individual modules and configuring your Windows firewall to allow for
communication.

Niagara 4 FAQs

Questions and answers specifically about Niagara 4.
Q: Why does an installation have so many “homes”?

A: The multi-homed directory structure results in improved security. Because configuration data is separated
from runtime data, users do not require full access permissions to the installation. This allows administrators
flexibility in regulating access. For more details on the homes, refer to the Niagara Platform Guide.

Q: The new station that | just created does not show-up in the Application Director view. How am |
supposed to start the station?

A: The New Station Wizard creates the station in your Workbench user_home. To start the station in the
Application Director, you must first copy the station, using the platform Station Copier, to the platform
daemon user_home .

NOTE: The final (Finish) step of the wizard includes several action-on-Finish options, one of which is: Copy
station to secure platform for “localhost” on Finish. If selected, on finishing the wizard closes
and the platform Station Copier appears.

Q: Why on my Supervisor PC am | required to make a local platform connection and the Station Copier to
copy (transfer) a station to the daemon user home from my Workbench user home, when | could more
easily just use Windows Explorer to copy and paste folders and files there?

A: Bypassing platform tools, even with “localhost” operations, increases security risks. In the example cited, if
you simply copy and paste a station folder using Windows Explorer, client passwords in that station are left in a
portable format. Whereas if you use the Station Copier, those passwords become encrypted with the unique
keyring files for the opened platform.

Q: Will other Windows users with admin privileges who log on to the PC where the installation exists be
able to see the Start menu shortcuts, installation folders, etc?

A: The shortcuts are visible only to the original installer. Other administrator-level users, logged on to the
Windows PC, can make their own shortcuts to Workbench, etc., or simply navigate to the installation folders to
start Workbench. The result is that the user gets their own unique Workbench niagara_user_home
(C:\Windows\users\userName\Niagara 4.x, a separate location from that of the user who installed the
framework.

Different Windows logons have different niagara_user_homes, which is by design, it protects any passwords
you may be using. This also means that sharing backups (and other items) with other users requires some
thought.

Q: Is it possible to use Workbench with an earlier release of Niagara installed on a controller?
A: No, you need to use a version of Workbench that is compatible with the software on the controller.
However, a remote controller can be integrated in the Niagara 4 Supervisor's station, where you can discover

points, schedules, and histories. Also if the Supervisoris configured for provisioning, it can do provisioning
tasks on a remote controller . Refer to the Niagara AX to N4 Migration Guide for related details.
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General FAQs

Questions and answers on the framework.

Q: From my engineering workstation, | need to support different jobs at different software release levels.
Is there a recommended method to do this?

A : You can install different release levels on your workstation, and keep them separate by installing them in
different locations. To run stations locally, remember to check which platform daemon is running at the time
(from command prompt: services.msc and look at Niagara service). As needed, use the shortcut Install

Platform Daemon to start the appropriate platform daemon.

Q: Is it possible to select which modules are installed?

A: By default, the installer installs all modules in your !modules folder. These include all the online versions of
software documents, such as (Getting Started with Niagara) and so on, various lexicon modules, and all the
software modules, including ones for drivers and other features.

NOTE: When you use Workbench to install software in remote hosts (typically JACE controllers), you do select
which modules to install, among them all the software modules in your !modules folder, as well as other items
in your software database (! sw folder).

Q: Does Niagara require changes to my Windows Firewall?

A: Most configurations work with the default ports. You would make changes to your firewall to run a station
locally on a PC with other remote stations connected to it, or to allow a remote Workbench client to connect to
the station and platform on this host.

Q: When installing Niagara on a Supervisor, is the software supposed to be installed with the "use as
install tool” box checked? Is there any reason not to check this box?

A: This box is optional because the installation is 200MB bigger when it is selected. You need to have it
checked if the Supervisor will be using provisioning to install software to subordinate controllers, or if you want
to use Workbench from that computer to upgrade software on a controller.

Q: What is the difference between wb_w.exe and wb.exe?

A: Starting Workbench using wb . exe starts an associated console window that provides debug information for
the client Workbench application in much the same way that the application director provides server-side
debug information for the station. It is typical to start Workbench using wb . exe when trouble shooting client
side issues.

Starting Workbench using wb_w.exe launches the program without a console window. You may prefer to use
wb . exe because of the console. If Workbench freezes with a console open, you can quickly terminate the
program by closing the console window.

Q: I've got different versions of Workbench installed. When is it really necessary to start the platform
daemon?

A: You only need to start the platform daemon when you are planning to run a station locally. However, it does
not hurt to get in the habit of loading the platform daemon for the current release each time you launch
Workbench. Some customers use batch files for starting the platform daemon followed by starting the
program. This simplifies things because you can just double-click the shortcut icon for the particular version
and brand of Workbench you need. Customers share such solutions on Niagara Community.
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Chapter 6. Glossary

The following glossary entries relate specifically to the topics that are included as part of this document.
To find more glossary terms and definitions refer to glossaries in other individual documents.

Alphabetical listing

engineering workstation

An installation of Niagara on a PC, which is used to commission controller hardware and perform application
engineering on both offline and online stations. In some cases the this workstation may also be licensed to run
a station to facilitate application development and testing.
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